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In this guide, you’ll find general information about how Outlook 2007
and SharePoint Server 2007 work together. These products offer the
ability to use Outlook 2007 to view and edit SharePoint Server 2007
collaboration resources.

Outlook 2007 and SharePoint Server 2007
Together
In SharePoint Server 2007, you can create resources for team collaboration
and then connect them to Outlook 2007 so that team members can
collaborate with them there.
Because of this connectivity, you can stay in the familiar environment of
Outlook 2007 and work directlyy on SharePoint Server 2007 resources. You
can even work on the resources offline, because your changes will be
synchronized when you go online. This way, you can work no matter what
your connection status is.
SharePoint Server 2007 resources refers to the SharePoint Server 2007
tools designed to assist in group collaboration. These resources are usually
lists, such as contact lists and task lists, but they can also be calendars, or
documents in progress.
There are five types of resources that can be used in Outlook 2007:
• Calendar
• Task List
• Document Library
• Discussion Board
• Contact List
See the following table for descriptions of these resources.

Apptix Live Support: 866-688-0128

Resource

Description

Calendar

Use calendars to schedule projects, appointments,
and milestones. A SharePoint Server 2007 calendar
can be viewed side
side-by-side
by side with an Outlook 2007
calendar, or the two calendars can be overlaid to
view all items at once. You can drag an item to your
Outlook 2007 personal calendar to see it on a mobile
device.

Task List

Use task lists to assign project duties and track them
to conclusion. Team members can see all project
tasks in the Tasks window, or can view tasks
assigned only to them in the To-Do Bar.

Document
Library

Team members use document libraries to preview,
search, and open project documents. Site members
can edit documents locallyy or offline. Office reminds
members to update the SharePoint server with
changes, as necessary.

Discussion
Board

Use Discussion Boards to discuss specific topics
during the course of a project. While e-mail
discussions require participants to find and sort many
messages Discussion Boards isolate messages for
messages,
easy tracking.

Contact List

Use Contact Lists to stay in touch with other team
members and with important people outside the
team. And as one member adds contacts to a list or
edits it, the entire team gets the new information.

Consider what resources your project needs and then add them to your
SharePoint Server 2007 site. After you connect them to your own Outlook
2007 mailbox, you can share them with others.
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Connecting Outlook 2007and SharePoint
Server 2007
It’s easy to connect resources to Outlook 2007 and then share the
connection with others. After creating a resource on a site—for example, a
task list or a calendar—go to the resource and, on the Actions menu, click
Connect to Outlook.

To share your connection with others, go to a SharePoint Server 2007 folder
in the Mail pane, right-click the folder, and then click Share [resource
name]. In the message window that appears, send invitations to share the
resources.

When the connection is made, the resources appear as folders in your
Outlook 2007 mailbox. The folders are listed in the Mail pane under
SharePoint Lists. SharePoint calendars do not appear as folders. Instead,
they appear with other calendars in the Calendar pane.

To accept an invitation and connect to the same resources in Outlook 2007,
invitees click a button in the message.
After connecting to the resources,
resources invitees can begin collaborating with the
resources in Outlook 2007.
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Online and Offline
To get the greatest benefit from working in Outlook 2007 and SharePoint
Server 2007, it helps to understand the difference between the online and
offline synchronization experiences.
When you
are online

Edits made in Outlook 2007 to resources are
automatically synchronized with the master files on the
SharePoint Server 2007 site. These changes are
synchronized with those made by others who share the
connection in Outlook 2007
2007.

When you
are offline

You can view and edit cached versions of resources, but
your edits are not synchronized with the master files on
the SharePoint Server 2007 site, and not synchronized
with those made by others until you go online. Go online
periodically to trigger synchronization.

• Documents you have edited but not yet updated can be found inside
your SharePoint Drafts Search Folder.

Tip To prevent the loss of information when more than one person is
working on a document at the same time, turn on version control at the
SharePoint Server 2007 site, or check out the document before you begin
working on it.
Notes
• When editing documents, you must first make a local copy of the
document, edit it offline, and then manually synchronize your changes
with the SharePoint site. You will be prompted to do so.
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3
Microsoft® Office Outlook® 2007 enables you to manage your time by
separating your personal and business calendars, and allowing you to
view
i
them
h
at one time.
i
For
F example,
l you may find
fi d it
i useful
f l to separate
your personal appointments from business appointments by creating
two different calendars. Also, if you schedule projects or team events
in the calendar on a Microsoft® SharePoint Server 2007 site, you can
connect this calendar to Outlook 2007.
With Outlook 2007
2007, using multiple calendars is efficient
efficient—you
you can view
and use the calendars individually or together.
Topics in this guide include:
•
•
•
•

Create Additional Calendars
Connect to SharePoint Server 2007 Calendars in Outlook 2007
View Multiple Calendars
Move Appointments between Calendars

In the Name box, type a name for the new calendar, and then click
OK.
The calendar name and a check box
appear under My Calendars.
Calendars Repeat this
process to create additional calendars.

Connect to SharePoint Server 2007
Calendars in Outlook 2007
View and use calendars from both programs in Outlook 2007. For example,
if your team uses a calendar on a Team Site to track vacations, you may
want to view this calendar in Outlook 2007 when scheduling team meetings
t
or events.
View and work with the calendar from either Outlook 2007 or from the
SharePoint Server 2007 site. Because the two calendars are linked, any
changes you make are saved in both calendars.

Create Additional Calendars

Important
p
A calendar on a SharePoint Server 2007 site is required
q
to
complete this procedure.

1

In the Outlook 2007 navigation pane, click Calendar.

1

Navigate to a calendar on a SharePoint Server 2007 site.

2

Under My Calendars, right-click
Calendar, and then click New Folder.

2

Click Actions, and then click
Connect to Outlook. In the
Microsoft Office Outlook dialog
box, click Yes. The calendar from
the site will appear next to your
other calendars in Outlook 2007.
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View Multiple Calendars
There are three ways to view your calendars: one at a time, side by side, or
overlaid on top of each other. Whichever view you use, you can move
calendar items between the calendars and create or delete items on the
calendars
calendars.

As you select calendars, they appear side-by-side in the main window. To
close a calendar, clear its check box.

One-at-a-Time View
After adding additional calendars, there may be times when you want to
view just one of the calendars.

1
2

In the Outlook 2007 navigation pane, click Calendar.
Under My Calendars, clear all the check
boxes except the one next to the calendar
you want to view.

Side-by-Side View
Side-by-side viewing is ideal for moving appointments between calendars.

1

In the Outlook 2007 navigation pane, click Calendar.

2

Under My Calendars, select the check
box next to each calendar you want to
view.

Tip To create more viewing room on your screen, collapse the left
navigation pane or the To-Do Bar. To collapse one of these, go to the top of
the left navigation pane or the top of the To-Do Bar, and then click the
p
the pane,
p
, click the arrow again.
g
arrow. To expand

Navigation Pane

Apptix Live Support: 866-688-0128

To-Do Bar
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Overlay View
Overlay view is ideal for identifying scheduling conflicts. By using a
transparent overlay with color
color-coded
coded calendar items,
items overlay view allows
you to see all your meetings as if they are on one calendar.

1

In the Office Outlook navigation pane, click Calendar.

2

Under My Calendars, select the check
b nextt tto each
box
h calendar
l d you wantt to
t
overlay. The calendars appear side-byside.

3

On the tab of any calendar you want to overlay, click the arrow. As you
click the tab arrows of various calendars, the calendars overlay across
each other.

Apptix Live Support: 866-688-0128

Tips
• To bring
g a calendar to the front,, click the calendar tab or an
appointment.
• To move a calendar back to side-by-side view, click the tab arrow.
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Move Appointments between Calendars

Delete a Calendar

Moving appointments keeps them attached to specific calendars, and
prevents others from seeing personal items. For example, if you move
personal appointments to secondary calendars they cannot be shared with
others because only your main (default) calendar or calendars from
SharePoint Server 2007 sites can be shared.

If you no longer need a calendar, remove it.

1

Open two or more calendars in side-by-side view.

2

To mo
move
eo
or cop
copy appointments
appointments, do one of the follo
following:
ing
To move an appointment, right-click it, click Cut, and then paste it on
the other calendar.
–OR–

1

Under My Calendars,
Calendars right-click the name of the calendar you want to
remove.
Note Your main calendar cannot be removed.

2

Click Delete [calendar name].

Restore a Calendar
The way you restore a calendar depends on where the calendar was
created.
Restore a Calendar Created in Outlook 2007

To copy an appointment,
T
i
right-click
i h li k it,
i click
li k Copy,
C
and
d then
h paste it
i on
the other calendar.

1

From the Go menu, click Folder List. In the Folder List, expand the
Deleted Items folder.

Note Single occurrences of an appointment series cannot be moved to
another calendar; however, you can copy a single occurrence. To move an
entire appointment series, you must move the first meeting in the series.

2

Drag the calendar from the Deleted Items folder to the Calendar
folder.

Note If the calendar no longer exists in the Deleted Items folder, it is
permanently deleted and cannot be restored.
Restore a SharePoint Server 2007 Calendar
If you mistakenly remove a SharePoint Server 2007 calendar from Outlook
2007, restore it by going to the site and reconnecting the calendar. For
d t il see the
details,
th “C
“Connectt tto Sh
SharePoint
P i tC
Calendars
l d
iin O
Outlook”
tl k” ttopic
i earlier
li in
i
this guide.
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Add a Second Time Zone to a Calendar
If you work with people in other geographic locations, adding a second time
zone to your calendar can help you manage the time differences
differences.

1

On the Tools menu, click Options.

2

Under Calendar, click Calendar Options.

3

Under Advanced options, click Time Zone.

4

Select the Show an additional time zone check box.

5

In the Label box, type a description, such as “Tokyo.”

6

In the Time zone list, click the time zone, and then click OK. The
second time zone appears next to your default time zone.

Tip When you enter the area with a different time zone, you can use the
secondary time zone as your main calendar time by going into
Tools>Options>Calendar Options>Time Zone. In the Time Zone
dialog box, click Swap Time Zones. This syncs all your calendar items with
the new time zone. To switch back, click Swap Time Zones again.
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Tasks in the Microsoft Office system are similar to a to-do list. Tasks
make it easy to use Microsoft® Office Outlook® 2007 to organize your
time and your work. Tasks are integrated across Outlook 2007,
Microsoft® Office SharePoint® Server 2007, and Microsoft® Office
OneNote® 2007—enabling you to smoothly work between applications.

To-Do Bar Task List
Includes flagged
e-mail messages,
tasks, and
downloaded
SharePoint Server
2007 tasks.

Topics
T
i in
i this
thi guide
id include:
i l d
• About the To-Do Bar in Outlook 2007
• Create a Task in Outlook 2007
• Flag Incoming E-Mail Messages for Follow-Up
• Attach Files and E-Mail Messages to a Task
• Use Outlook 2007 to Work with SharePoint Server 2007 Tasks
• Create an Outlook 2007 Task from Microsoft® Office OneNote®
2007

About the To-Do Bar in Outlook 2007
The To-Do Bar includes calendar and task information. Tasks include regular
tasks in the task folder and e-mail messages flagged for follow up.
Most of the procedures in this guide use the To-Do Bar. If the To-Do Bar is
not displayed on your screen, go to the View menu, point to To-Do Bar,
and then click Normal.

Apptix Live Support: 866-688-0128

Daily Task List Displayed in Calendar
Completed tasks stay on the day of completion in your calendar and are
recorded as work performed on that day. Tasks not completed move on to
the next day until they are completed.
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Create a Task In Outlook 2007
1

On the To
To-Do
Do Bar
Bar, in the Type a new
task box, type the name of the new task,
and then press ENTER to complete
creating your task.

2

To add a specific start date, due date, reminder, or any additional
information, double-click the task in the To-Do Bar Task List. Make
changes in the task window, and then click Save & Close.

The task appears in the To-Do Bar Task
List with a default due date of the current
date.

Tip To create a task from an Outlook 2007 item, drag the item (such as an
e-mail message, contact, or calendar event) onto the Task List in the To-Do
Bar.
Note If the Type a new task box does not appear, on the To-Do Bar
Task List, right-click the Arrange By bar, click Custom, and then click
Reset Current View. Click OK.

Apptix Live Support: 866-688-0128
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Schedule Time for an Outlook 2007 Task

Flag Incoming E-Mail Messages for Follow-Up

Schedule time in your Outlook 2007 Calendar to work on a task, or schedule
a meeting to talk about a task.

Use flags to add an incoming e-mail message to the Tasks list. When you
flag an e-mail message, it appears in the Daily Tasks List in the Calendar
and in the To-Do
To Do Bar Task List
List.

1

On the Outlook navigation pane, click Calendar.

2

Drag the task you want to schedule time for from the To-Do Bar Task
List to the Calendar.

1

Right-click the flag icon on an unopened e-mail message.

2

Click the flag with the preferred due date. To choose specific start dates
and due dates, click Custom.

Tips

3

Double-click the calendar appointment you created. On the
Appointment tab, select the options you want, and then click Save &
Close.

Apptix Live Support: 866-688-0128

• To apply the default flag (Today), click the flag icon on the e-mail
message. To mark the task complete, click the flag again and a check
mark appears.
• To change the default flag, click the flag icon on the e-mail message, and
then click Set Quick Click.
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Flag Outgoing E-Mail Messages as a Reminder

Attach Files and E-Mail Messages to a Task

To remind yourself to follow up on e-mail messages you’re sending, add
g when you
y send e-mail messages.
g
flags

Attach related files and e-mail messages to a task—task-related content is
conveniently
co
e e t y located
ocated in o
one
ep
place.
ace

Note When you flag e-mail messages, the flags are only viewable by you—
unless you specifically set a flag for the recipients as well.

1

1

Create a new e-mail message.

2

On the Ribbon, on the Message tab, click Follow Up, and then click
the time on which you want to follow up.

Open a task.
Note This procedure will not work with flagged e-mail messages. To
make sure you actually opened a task, the window must be labeled with
“[Task
[Task Name] - Task
Task” at the top and include a Task tab.
tab

2

Select the file or e-mail message, and then drag it into the Task
window.
Tip You may need to resize your windows to drag items into the Task
window.
window

Notes
• If you want to also set a flag for the recipients, click Follow Up, and
then click Flag for Recipients.
• To set a specific date for follow up, click Custom, and then click a date
that you want.

3

Apptix Live Support: 866-688-0128

Click Save & Close.
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Mark a Task Complete
• On the To-Do Bar Task List, rightclick the flag to the right of the task,
and
d then
th click
li k Mark
M k Complete.
C
l t
The task no longer appears in the
To-Do Bar Task list and appears as
complete in the tasks To-Do List.

Tips
• To mark a task complete, right-click
on the task and then click Mark
Complete. Or in the Outlook
navigation pane, click Tasks, and
then select the check box to the left
of the task.

Use Outlook 2007 to Work with SharePoint
Server 2007 Tasks
With Outlook 2007,
2007 you can now view and change tasks that exist on your
Team Site. Any changes that you make to tasks in Outlook 2007 are
automatically synchronized with SharePoint Server 2007.
To use Outlook 2007 to view and edit SharePoint Server 2007 tasks, you
must connect Outlook 2007 to the SharePoint Server 2007 Task list. After
you do, the SharePoint Server 2007 tasks appear in your Outlook 2007
Tasks list
list.
Note Working with SharePoint Server 2007 tasks in Outlook 2007 requires
a SharePoint Server 2007 site.

• To delete a task, click Tasks in the
Outlook navigation pane, right-click
the task, and then click Delete.

Apptix Live Support: 866-688-0128
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Notes

Connect Outlook 2007 to a SharePoint
Server 2007 Task List
1

On a Team Site or My Site, in the left navigation pane under Lists, click
Tasks.

2

On the menu bar, click Actions,
and then click Connect to
Outlook. In the Microsoft
Office Outlook dialog box,
click Yes.

• If you receive a task e-mail
message from a SharePoint
2007 site, you can
automatically connect Outlook
2007 to a SharePoint 2007
Task list. See the next topic,
“Respond to a Task E-Mail
Message from a SharePoint
Server 2007 Site.”
• As with any SharePoint Server
2007 site, you need the proper
permissions to view, edit, add,
and delete items. If you do not
have the correct permissions to
the SharePoint Server 2007
task list, you need to request
access from the site
administrator.

All tasks are now added to your
Outlook 2007 Tasks List. Only
the tasks assigned to you are
displayed in the To-Do
To Do Bar task
list and the Daily Task List.
Repeat the procedure above for
each SharePoint Server 2007
Task List you want to connect
to Outlook 2007.

Outlook Tasks List

Respond to a Task E-Mail Message from a
SharePoint Site
When you receive a task e-mail message from a SharePoint Server 2007 site
in your inbox, you can add the task to your Outlook 2007 task list. When
you add the task,
task Outlook 2007 automatically creates a connection to the
SharePoint 2007 Task List. All the tasks in the SharePoint 2007 Task List will
be displayed and synchronized in your Outlook 2007 Task List.
Only the tasks assigned to you that you received in your inbox are displayed
in the To-Do Bar Task List and the Daily Task List.

Apptix Live Support: 866-688-0128
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• In the reading pane of Outlook 2007, in the SharePoint Server 2007 task
e-mail message, click View and Synchronize ‘[Task List Name]’ list.

Use Outlook 2007 to Create SharePoint
Server 2007 Tasks
You can create and assign tasks from Outlook 2007 to a SharePoint Server
2007 task list. This allows you to use Outlook 2007 to manage tasks that
exist on a SharePoint Server 2007 site.
Note To complete the procedure below, you must be connected to a
SharePoint Server 2007 task list. See “Connect Outlook to a SharePoint
Server 2007 Task List” earlier in this guide.

1

On the Outlook 2007 navigation pane, click Tasks.

2

In the All Task Items
section, under Other Tasks,
cclick
c tthe
eS
SharePoint
a e o t ssite
te
where your tasks reside.

3

On the File menu, point to New, and then click Task.

4

In the task window, add a specific start date, due date, any additional
information, or assign the task, and then click Save & Close. Any
changes made to the task in Outlook are saved to the SharePoint tasks
list.

After you click the link, the task on the SharePoint Server 2007 site is added
to your To-Do Bar task list. A folder with the SharePoint Server 2007 Task
List name also appears under Other Tasks in the tasks navigation pane.
Note To opt-out of receiving SharePoint Server 2007 Tasks in Outlook
2007 click Modify Notification Settings in the body of the SharePoint
2007,
Server 2007 task e-mail message.

Note Only the tasks assigned to you are displayed in the To
To-Do
Do Bar task
list and the Daily Task List.
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Create an Outlook 2007 Task from OneNote
2007

3

Create Outlook 2007 tasks using OneNote 2007, and then view and manage
th ttasks
the
k using
i O
Outlook
tl k 2007
2007. Changes
Ch
you make
k to
t these
th
tasks
t k in
i Outlook
O tl k
2007 or OneNote 2007 are synchronized automatically.
1 Click the note to which you would like to add a task.

OR
-ORTo add task details in
Outlook 2007, doubleclick the task in the ToDo Bar task list.

4

2

On the Insert menu, point to Outlook Task, and then click a flag. The
flagged task now appears in Outlook 2007 on the task list and the ToDo Bar Task List
List.

To add task details in
OneNote 2007, right-click
the flag, and then click
Open Task in Outlook,

In the task window, add a
reminder, any additional
information, specific start
or due dates, or assign
the task, and then click
Save & Close
Close.
The task is now in your
OneNote 2007 notes and
Outlook 2007 To-Do Bar
task list. You can manage the task using Outlook 2007.

Notes
• Make minor changes to the task in OneNote 2007 without opening the
task in Outlook 2007. In OneNote 2007, right-click the flag next to the
note, and then click a flag, mark the task complete, or delete the task.
The change is automatically saved in Outlook 2007. To make more
d t il d changes,
detailed
h
open the
th task
t k in
i Outlook
O tl k 2007 as described
d
ib d earlier
li in
i
this guide.
• To go from the open task in Outlook 2007 to the OneNote 2007 page
where the task resides, double-click the OneNote 2007 icon in the task
body. See the image earlier in this guide.
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